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BAB 111

PETUNJUK PEMAKAIAN PROGRAM

3.1.  Mengenal POSTSAP 1.00

POSTSAP merupakan program desain yang berbasis windows yang
diciptakan dan dikembangkan untuk menyelesaikan perhitungan desain beton
bertulang khusus untuk elemen kolom dan balok saja. Program ini dirancang hanya
untuk menyelesaikan kasus desain struktur portal dua dimensi yang didasarkan pada
peraturan bangunan yang berlaku di Indonesia yaitu SK SNI 03-2847-2002. Dalam
proses pembuatannya, POSTSAP menggunakan bahasa pemrograman visual basic
6.0. Program ini tidak ditujukan untuk kasus perancangan gedung yang mengalami
pembebanan khusus, misalnya beban gempa , atau gedung bertingkat banyak.
POSTSAP dalam proses perhitungannya membutuhkan file hasil analisis SAP2000
yang disimpan dalam format *.MDB sebagai input.

Untuk memudahkan dalam penjelasan petunjuk pemakaian program, maka
dalam bab ini diberikan contoh kasus penyelesaian perhitungan desain gedung tiga

lantai dengan geometri dan parameter desain sebagai berikut:
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Gambar 3.1. : Struktur Portal 2D dan Pembebanannya
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Dimensi Elemen dan Karakteristik Material:

— Ukuran kolom =400 x 400 mm dengan selimut beton (cv) = 50 mm.
— Ukuran balok = 300 x 600 mm dengan selimut beton (cv) =40 mm
— Berat jenis beton ( weight per unit volume )  =240000 N/mm3
— Modulus elastisitas ( modulus of elasticity) = 20000 MPa.
— Angka Poisson ( Poisson ratio ) =0,2.
Mutu beton dan tulangan:
— Tulangan pokok ( fy) =400 MPa
— Kuat tekan beton (f’) =25 MPa

— Tulangan geser (fys) = 240 MPa
— Diameter tulangan utama (db) =16 mm

— Diameter tulangan sengkang (dbs) =10 mm

3.2.  Memulai POSTSAP 1.00
1) Klik Start > all program > postsap > postsap.exe
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Gambar 3.2. : Memulai POSTSAP




2) Akan tampil layar pembuka (splash) dari POSTSAP
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Gambar 3.3. : Layar Pembuka POSTSAP

3) Muncul menu POSTSAP sebagai berikut:

POSTSAP ¥1.00

Fle Data Dessin Display Tools Preferences Help

= L = il
Load Run Result RC BALOK. Calc
~Log

BTG TEAE for windows wel 1.01

Time: 2/22/2009 150857

struksi yang dijalankan oleh program|

Ready

Gambar 3.4. : Menu Utama POSTSAP
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3.3.  Load File SAP2000 MS. Access Database .MDB
1) Masukkan file SAP2000 MS. Access Database .MDB sebagai input program

dengan cara Menu File > Load SAP2000 MS. Access Database .MDB.
S

File Data Desain Display Tools  Preferences Help

Load SAP2000 MS Access Database MO File. .. Chri+HL
Exit Chrl+2

Log
POSTSAE forwindaws wer 1.0
Time: 2/22/2009 15:08:57

Ready

Gambar 3.5. : Perintah Load pada POSTSAP
2) Akan tampil Load form yang meminta pemasukan nama file SAP2000 MS.
Access Database .MDB. Dalam kasus kali ini, nama filenya adalah 2D.MDB.

Klik OK untuk menyetujui pemilihan nama file.
[ rosswvion Y

File Data Desain Displsy Tools Prefererices Help

=

= b = O sl
Load Run Result RC BALOK Calc
Log
FOSTSAP for windows ver 1.0
TSl 2l
Lok in: I\'j 2D j L] £ E-

Type: Microsoft Office Access Application
Date Modified: 2/19/2009 4:50 PM
Size: 844 KB

by Documents

"

My Computer

File name: |2D rdb j Open

Files of type: [54P2000 M3 Acoess Database® mdh = Cancel

Ready

Gambar 3.6. : Input File SAP2000 MS. Access Database .MDB
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3) POSTSAP akan mengecek apakah file database yang dimasukkan adalah file
SAP2000 MS. Access Database .MDB. atau tidak. Jika benar maka form

section dan frame assignment akan muncul. Jika salah maka akan muncul

pesan "Database yang dimasukkan tidak bisa dibaca oleh program, cek file

database yang dimasukkan. "'

X
File Data Desain Display Tooks Preferences Help
[ » | = g
Load Run Result RC BALOK Cale
rLog
POSTSAP for windows wer 1.0 -
Time : 2/22/2009 15:08:57 I~
Time: 2/22/2009 15:34:17
File : E:\TAMvalidashSAPY2DN20.mdb
Walidasi database berhasil
Pembacaan data koordinat joint berhasi
Pembacaan data frame berhasil
Pembacaan data frame section assignment berhasil
Pembacaan data kontrol program berhasil
Pembacaan data material = o
[t naer il 1 formasi loading database x|
Pernb data fi
P:mh:i::: d:t: E';T"i:f Database yang dimasukkan tidak bisa dibaca oleh program, cek file database yang dimasukkan,
make arap
Proses loading Ok,
Time: 2/22/2009 15:34:
File : C:\Documents and SettingshJiunMy Documentst10.mdb
Yalidasi databass berhasil
Pembacaan data koordinat joint berhasi
Pembacaan data frame berhasil
Pembacaan data frame section assignment berhasil
Pembacaan data kontrol program berhasil
Pembacaan data material berhasil
Pembacaan data material section berhasil
Pembacaan data frame section properties berhasil =
Permbacaan data element forces - frame berhasil
make array ...
Proses loading Ok _I

processing deta.

Gambar 3.7. : Pesan Yang Muncul Jika File Yang Dimasukkan Bukan File

SAP2000 MS. Access Database .MDB.
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Gambar 3.8. : Form Section dan Frame Assignment Akan Muncul Jika File
SAP2000 MS. Access Database .MDB Yang Dimasukkan Benar.



3.4.
1) Masukkan data mate
2)

3)

POSTSAP v1.00 - E\TA\validasi\SAl
Display Tools Preferences Hel

File Data Desain

I11-6

Menentukan Material

rial beton dan baja dengan cara Menu Data > Material

Akan muncul form material dan isikan data pada kotak yang tersedia.

Klik OK untuk menyetujui pengisian data material.

b

=
Resuk

=
Load

-

Run

)
RC BALOK

Calc

~Log

POSTSAP for windows ver 1.0
Time : 2/22/2009 150857

File: EATAY
W alidasi datz
Pembacaan
Pembacaan
Pembacaan
Pembacaan
Pembacaan
Pembacaan
Pembacaan
Fembacaan

Kuat tekan beton, f'c (MPa]
Kuat leleh tulangan utama, fy (MPa)

Kuat leleh tulangan sengkang, fvs (MPa]

.
Time : 2/22; =

Muodulus elastisitas tulangan baja, Es (MPa)

oK Cancel

x|
200000
E
400
240

make aray -
Froses loading OK

Time : 2/22/2009 15:34:53

Validasi database berhasi
Pembacaan data kaordinat joint berhasi
Pembacaan data frame bethasi

Pembacaan data frame section assignment berhasi
Pembacaan data kontrol program berhasi
Pembacaan data material berhasi

Pembacaan data material section berhasi
Pembacaan data frame section prapetties berhasil
Pembacaan dats slement forces - frame berhasil
make airay

Proses loading OK

File : C:\Documents and SettingsJiunkMy Documentsi10.mdb

Ready

Gambar 3.9. :

Form Material Untuk Pengisian Data Material Beton dan Baja.

3.5.
1)
2)

Mengisikan Data Proyek

Masukkan data proyek dengan cara Menu Data > Project

Akan muncul form data project dan isikan data pada kotak yang tersedia.

Klik OK untuk menyetujui pengisian data project.

3)

- POSTSAP v1.00
File Data Desain

Y Toos Preferences

Help

=

Result

= [t
Load Run

RC EALOKl

Calc

—Log

POSTSAP for windows ver 1.0
Time: 2/22/2009 150857

Time : 2/22/2008 153417

File  EATAMvalidashSAP\2DN2D e
Validasi database berhasi
Pembacaan data kaardinat joint berk
Pembacasn data frame bethasi
Pembacasn data frame section assic
Pembacasn data kontrol program be
Pembacaan data material berhasi
Pembacaan data material section be
Pembacaan data frame section prop
Pembacaan data element forces - fic
make aray .

Proses laading OK

Time : 2/22/2008 15:34:53

File . C:ADocuments and Settingsuic
Validasi database berhasi
Pembacaan data kaordinat joint berk
Pembacasn data frame bethasi
Pembacasn data frame section assic
Pembacaan data kontrol prograr be

Data Proyek Form u

Nama perusahaan

Mama klien
Mama proyek

Lokasi proyek,

Nana enginesr
Checker

Supervisor

|PT. Duta Perkasa Tok.

|PT. Bangun Sejahtera Tk

[Proysk Pembangunan Hotel Megah

L Pemuda MNo. 14 Capu, Blora, Jawa Tengah

[Krisyanto 5T. danJoko 4ji 5T

[De Horodi, MT dan Ir. Funwanto, MT MEng

[Drlt. Nuradii, MT dan Ir. Purwanto, MT.MEng

ok Cancel

Pembacaan data material berhasil

make aray .
Proses laading OK

Pembacaan data material section berhasil
Pembacaan data frame section properties berhasil
Pembacaan data element forces - frame berhasil

Feady

Gambar 3.10.

: Form Data Project Untuk Pengisian Data dan Informasi Proyek



3.6.  Menampilkan dan Mengubah Data Frame Section
1) Masukkan data proyek dengan cara Menu Data > Frame Section
2) Akan muncul form section dan isikan data pada kotak yang tersedia.

3) Kilik OK untuk menyetujui pengisian data section..

POSTSAP ¥1.00 - E:\TA\ validasi\5AP} 2D\ 2D.mdb x|
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Pembacaan data frame section praperties berhasil
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make aray

Proses loading OK

Ready

Gambar 3.11. : Form Section Untuk Pengisian Data Section

3.7. Menjalankan Proses Desain
1) Jalankan proses desain dengan cara Menu Desain > Run Desain
2) Akan muncul form option. Klik OK untuk menjalankan proses desain.

Result

RC BALOK Calc |

rLog
PRSTSAP for vandows ver 1.0 -
Time : 2/22/2009 15:08:57 1

Time : 2/22/2003 153417

File : E:ATAwalidasivSAPA20%20. mdb

Validasi database berhasil

Pembacaan data koordinat joint berhasil
Pembacaan data frame berhasil

Pembacaan data frame section assignment berhasil
Pembacaan data kantral program berhasil
Pembacaan data material berhasi

Pembacaan data material section berhazil
Pembacaan data frame section praperties berhasil
Pembacaan data element forces - frame berhasil
make aray

Prozes loading OK

Time : 2/22/2009 15:34:59

File : C:\Documents and Settings\WJiuntty Documentsi10.mdb —
alidasi database berhasil

Pembacaan data koordinat joint berhasil
Pembacaan data frame berhasil

Pembacaan data frame section assignment berhasil
Pembacaan data kantrol program berhasil
Pembacaan data material berhasil

Pembacaan data material section berhasi
Pembacaan data frame section properties berhasil
Pembacaan data element forces - frame berhasil
make aray ...

Proses loading OK

Ready

Gambar 3.12. : Perintah Run pada POSTSAP
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POSTSAP v1.00 - EXTA idasi’SAPY 2D\ 2D.mdb

i
Filz Data Desain Display Tools Prefersnces Help
= > = o ™
Load Run Result RC BALOK Cale
Log
POSTSAP for windaws wer 1.0 N
Time : 2/22/2003 15:0857 =

Time : 2/22/2009 15:3417
File : EATAVwralidasivia SEome on e

i e e 5!
Pembacaan data koord
Pembacaan data frame
Pembacaan data frame POSTSAP akan melakukan proses desain struktur per elemen
Pembacaan data kartre yang dapat dispesifikan dalam bentang yang telah dianalisis
Pembacaan data materi oleh SAP2000

Pembacaan data materi
Cancel

Pembacaan data frame
Pembacaan data eleme
make armay ...

Proses loading DK

Time : 2/22/2009 15:34:59

File : C:\Documents and Settings'iunty Documents\10.mdb e
Validasi database berhasil

Pembacaan data koordinat joint berhasil
Pembacaan data frame berhasil

Pembacaan data frame section assignment berhasil
Pembacaan data kantral program berhasil
Pembacaan data material berhasil

Pembacaan data material section berhasil
Pembacaan data frame section properties berhasil
Pembacaan data element forces - frame berhasil
make aray ...

Proses loading OK

Ready

Gambar 3.13. : Form Option Untuk Menjalankan Proses Desain
3) Akan tampil Save form yang meminta mengisikan nama file .OUT tempat
untuk menyimpan file output dan data log POSTSAP. Dalam kasus Kkali ini,
nama filenya adalah 2D.OUT.
4) Kilik OK untuk menyetujui pemilihan nama file.
5) Akan muncul form POSTSAP Design Monitor.
6) Klik OK untuk menampilkan hasil desain.

POSTSAP v1.00 - E:\TA\validasi'5AP\ 2D\ 2D.mdh x|

File Data Desain Display Took Preferences Help

@ | | ol B |
o] LA 5 e s knj File z1x]

o — .
FOSTSAF for vindows » Savein: [ 3 e -l e @k E
Time  2/22/2008 15:0¢

IKANTILEVER.

Time: 2/22/2009 15:3¢

File : E:\TAMvalidashSAT
Walidasi database berhel
Pembacaan data koord
Permbacaan data frame
Pembacaan data frame
Pembacaan data kontrc
Pembacaan data materi
Pembacaan data mater
Permbacaan data frame
Pembacaan data eleme
make array

Proses loading OK.

Type: KM File
Date Modified: 2/22/2009 2:32 PM
Size: 4.92 kB

Time: 2/22/2008 15:3:

File : C:A\Documents and
Yalidasi databass berhas
Pembacaan data koordir
Pembacaan data frame b
Pembacaan data frame
Pembacaan data kontrol
Pembacasn data materiz
Pembacaan data materiz
Pembacaan data frame secoOTTOMpETES TEMEET
Pembacaan data element forces - frame berhasil
make array

Prases loading OF.

File name: Itede.km j Save I
Save as type |Pastsap File " knj = Cancel

|

Ready

Gambar 3.14. : Penyimpanan Hasil Desain Ke *.OUT



POSTSAP v1.00 - E:\TA\validasi| SAP\ 2D\ 2D.mdh

File Data Desain Display Tools Preferences Help
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= i = O ]
Load Run Resulk RC BALCK Calc
~Log

POSTSAP for windaws wer 1.0
Time: 2/22/2009 15:08:57

Time: 2/22/2008 15:34:17

File : E:A\TAMvalidashSAP 20420 mdb

W alidasi datsbass berhasil

Pembacaan data koordinat joint berhasi
Pembacaan data frame berhasil

Pembacaan data frame section assignment berhasil
Pembacaan data kontrol program berhasil
Pembacaan data material berhasil

Pembacasn data material section berhasi
Pembacaan data frame section properties berhasil
Pembacaan data element forces - frame berhasi
make aray ...

Proses loading OK.

Time: 2/22/2009 15:34:59
File : C:\Documents and Settings'Jiuntdy Documentsh 10

Walidasi databass berhasil
Pembacaan data koordinat joint berhasil

POSTSAP Design Monitor

Proses desain selesal

Pembacaan data frame berhasil

Pembacaan data frame section assignment berhasil
Pembacaan data kontrol program berhasil
Pembacaan data material berhasil

Pembacaan data material section berhasil
Pembacaan data frame section properties berhasil
Permbacaan data element forces - frame berhasil
make array ...

Proses loading Ok

Ready

Gambar 3.15. : Form POSTSAP Design Monitor Yang Menampilkan Log

P

3.8.

1) Setelah proses desain

roses Desain

Menampilkan Hasil Desain

dijalankan akan muncul form Output Desain yang

menampilkan hasil desain struktur.

2)
3)

Klik pada list elemen untuk menampilkan elemen struktur yang lain.
Untuk mengkspor ke excel klik perintah “Eksport Tabel ke Excel”
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Gambar 3.16. : Form Output Desain Untuk Menampilkan Hasil Desain



